Watershed Sciences 4930 & 6920
ADVANCED GIS

WEEK SIX - Lecture

ANALYSES COMBINING VECTOR AND RASTER DATA

Joe Wheaton

HOUSEKEEPING

• CONTOUR/ TIN Quiz due now!
• Questions????????????????????????????
  ?????????????????????????????????????
  ?????????????????????????????????????
  ?????????????????????????????????????
  ?????????????????????????????????????
  ???
YOUR EXCERCISE

• Integer Elevations
  - Rounded up elevations
• Elevations are real
  - Derived from 10 m DEM
• Here’s a few hints:
  - It’s in the mountains
  - You can see the AP

INSTRUCTIONS:
1. Connect all the dots to create a TIN
2. For each TIN edge, determine how many contours would intersect it at a 10m contour interval (lightly label the contour)
3. Connect the contours up to draw a contour map

YOUR TURN…

• Derive 10 meter Contours
• Make a TIN first
• Divide up the tin lines into your contour interval
• Connect the dots
• Label your Contours

INSTRUCTIONS:
1. Connect all the dots to create a TIN
2. For each TIN edge, determine how many contours would intersect it at a 10m contour interval (lightly label the contour)
3. Connect the contours up to draw a contour map
YOUR TIN

- Once you’ve connected the dots
- Figure out how many contours would intersect each line (if any)
- Locate where they would intersect (label them lightly)

YOUR CONTOURS

- Here’s the ArcGIS derived TIN shown w/ same 10 m contour interval you should have used
- How close does yours look to this?
ACTUAL

- Here's what the actual 10 m contours look like for this location
- Hillshade shown in background
- Both derived from USGS NED 10 m DEM

COMPARED

- Reasonably close...
- Why are they different?
- How many points did we use (i.e. sample)?
- How many points were used for brown contours?
- What is difference between contour interval, pixel resolution and point resolution?
TODAY’S PLAN

I. Contours

II. Raster Analyses
   I. Some Basics
   II. Map Algebra
   III. Map Algebra in ARC

LAST WEEK WE COVERED VECTOR-BASED SPATIAL ANALYSES

I. Selection
II. Classification
III. Proximity Functions & Buffering
IV. Vector Overlay
A good place to look for seeing what is available....
STILL A GOOD PLACE TO LOOK...

- Raster analysis tools are spread out throughout ArcToolbox
- Some in Data Management Tools
- Many in Spatial Analyst Extension

TODAY’S PLAN

I. Contours
 II. Raster Analyses
   I. Some Basics
     II. Map Algebra
     III. Map Algebra in ARC
SPATIAL SCOPE OF ANALYSES

• Three Basic Types AGAIN:
  1. Local operation function
  2. Neighborhood operation function
  3. Global operation function

1. LOCAL FUNCTION

• Use only data at one input cell location to determine value at corresponding same output cell location

[Diagram showing local function example]
2. NEIGHBORHOOD FUNCTION

- Use data from both an input location plus an n x n window of nearby locations to determine output value.

```
<table>
<thead>
<tr>
<th>10</th>
<th>12</th>
<th>42</th>
</tr>
</thead>
<tbody>
<tr>
<td>30</td>
<td>9</td>
<td>4</td>
</tr>
<tr>
<td>-12</td>
<td>8</td>
<td>15</td>
</tr>
</tbody>
</table>
```

3. GLOBAL FUNCTION

- Use data values from entire input raster to determine each output value.

```
<table>
<thead>
<tr>
<th>10</th>
<th>12</th>
<th>42</th>
</tr>
</thead>
<tbody>
<tr>
<td>30</td>
<td>9</td>
<td>4</td>
</tr>
<tr>
<td>42</td>
<td>42</td>
<td>42</td>
</tr>
</tbody>
</table>
```

Slides from USU Advanced GIS Courses by Wheaton et al. (2009-2013) is licensed under a Creative Commons Attribution-NonCommercial-ShareAlike 3.0 Unported License.
RECALL RASTER TERMINOLOGY

• All rasters have the following primary properties
  - Number of columns & rows (must be integers)
  - Cell resolution (grid size)
  - Type (integer, floating point precision)
  - Lower left coordinates \((x,y)\) or Top, Bottom, Right & Left coordinates (i.e. extents)
• From which the following secondary properties can be derived:
  - Width & Height

RECALL ORTHOGONALITY

• Orthogonal rasters must:
  - Share exact same grid resolution
  - Share the exact same grid centers (i.e. aligned in both easting and northing)
RECALL CONCURRENCE

• Grids are orthogonal and:
  - Share *exact* same extents

TODAY’S PLAN

I. Contours
II. Raster Analyses
   I. Some Basics
   II. Map Algebra
   III. Map Algebra in ARC
MAP ALGEBRA

- Map algebra is the cell-by-cell combination of raster data layers (i.e. LOCAL)
- One of the most common and flexible forms of raster analyses (virtually all raster analysis functions can be expressed with map algebra)
- Just like vector analyses, raster analyses can be local, neighborhood or global

MAP ALGEBRA: CONTINUOUS FIELDS

- Start with simple assumptions:
  - Cell-to-cell overlay is perfect
  - Unique match in each grid
  - All cells have a value
- Some interesting properties:
  - Analysis represented by combinations of single cell in each map, applied to all cells
  - Different cell-value combinations across maps leads to distinct patterns in the output map
  - The pattern of these combinations is of interest

New_Grid = A + B

![Diagram of map algebra for continuous fields](image-url)
### SIMPLE MATHEMATICAL OPERATIONS

New\_Grid = A + B

New\_Grid = A * B

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 1 0 0</td>
<td>1 2 2</td>
</tr>
<tr>
<td>4 -1 0 2</td>
<td>4 5 8 2</td>
</tr>
<tr>
<td>4 0 1 1</td>
<td>1 2 1 6</td>
</tr>
</tbody>
</table>

+ =

<table>
<thead>
<tr>
<th>1 4 0 7</th>
</tr>
</thead>
<tbody>
<tr>
<td>3 1 3 2</td>
</tr>
<tr>
<td>1 2 1 6</td>
</tr>
</tbody>
</table>

=

<table>
<thead>
<tr>
<th>2 5 0 0</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 5 4</td>
</tr>
<tr>
<td>2 5 4</td>
</tr>
<tr>
<td>2 5 4</td>
</tr>
</tbody>
</table>

### NESTED FUNCTIONS

- Series of operations can be ordered in a nested sequence (much like parentheses in a mathematical formula)
- Each operation produces a temporary-value raster
- The temporary “object” is used as a staging point in the calculation and as input for subsequent operations
- Thus, a raster can be represented as (1) an object OR as (2) the series of operations that produced it

\[
\text{Out\_grid2} = (\text{ingrid1} + \text{ingrid2}) - \text{ingrid3}
\]

Is the same as:

\[
\text{Out\_grid1} = \text{ingrid1} + \text{ingrid2}
\]

Followed by:

\[
\text{Out\_grid2} = \text{Out\_grid1} - \text{ingrid3}
\]
### Logical Operators

**Examples**
- Note the NAN handling
- Always return a true (1) false (0) boolean grid

**LOGICAL OPERATORS**

<table>
<thead>
<tr>
<th>Input</th>
<th>Output</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Input Example" /></td>
<td><img src="image" alt="Output Example" /></td>
</tr>
</tbody>
</table>

**LOGICAL COMPARISON OPERATORS**

<table>
<thead>
<tr>
<th>Input</th>
<th>Output</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Input Example" /></td>
<td><img src="image" alt="Output Example" /></td>
</tr>
</tbody>
</table>

Slides from USU Advanced GIS Courses by Wheaton et al. (2009-2013) is licensed under a Creative Commons Attribution-NonCommercial-ShareAlike 3.0 Unported License
MASKING

• A method for limiting the extent and location of calculations
  - Can reduce processing time
  - Saves output space (reducing extent also does this)
  - Can be used as an analytical tool

• Masks can be raster or vector
  - Vector files are converted to raster before processing
  - Analysis will be limited to wherever there are values in raster cells
  - Same as adding a No Data field to the map algebra operation

THE RASTER MASK (CLIP)

White Cells = No Data
HOW IT WORKS...

- Just a multiplication... (or an intersection)

```
Input raster
2 2 2 8 8 2 2 2
2 2 2 0 0 0 2 2
2 3 3 8 8 8 2 7
2 3 3 8 8 8 2 7
3 3 3 0 6 6 7 7
3 3 3 6 6 6 7 7
3 6 3 6 6 6 6 6
3 6 6 6 6 6 6 6

Clip raster
0 0 0 1 1 1
0 0 0 1 1 1
0 0 1 1 1 1 0
0 0 1 1 1 1 0
0 0 1 1 0 0 0
0 1 0 0 0 0 0
0 0 0 0 0 0 0

Output raster
0 0 0 0 0 0 0 0
0 0 0 0 0 0 0 0
0 0 0 0 0 0 0 0
0 0 0 0 0 0 0 0
0 0 0 0 0 0 0 0
0 0 0 0 0 0 0 0
0 0 0 0 0 0 0 0
0 0 0 0 0 0 0 0
```

RECALL MASKED EXTENTS

- Rasters that have the same masked extents, simply have the same nodata cells
- The mask can be derived from a polygon or a raster
- A concurrent raster mask is the most accurate!
MAP ALGEBRA: CONTINUED

• Some Clarifications
  - “A + B” represents adding the objects of A to those of B on a cell-by-cell basis
  
  - Thus far, we have discussed only single cell-to-single cell operations
  
  - These are repeated for every cell location in the raster = “Local” Analysis

TO DO MAP ALGEBRA, RASTERS NEED TO BE COMPATIBLE (i.e. Concurrent)

• Compatibility defined by orientation, origin and resolution
RESAMPLING (A FORM OF INTERPOLATION)

1. Nearest Neighbor Assignment
   - Good for discrete (categorical) data since it does not alter value of input
   - Once location of cell's center on output raster located on input raster, nearest neighbor assignment determines location of the closest cell center

2. Bilinear Interpolation
   - Uses values of 4 nearest input cell centers to determine the value of output
   - New value is a distance-weighted average
   - Results in smoother-looking surface than nearest neighbor...

3. Cubic Convolution
RESAMPLING (A FORM OF INTERPOLATION)

1. Nearest Neighbor Assignment
2. Bilinear Interpolation
3. Cubic Convolution
   - Similar to bilinear interpolation except that weighted average is calculated from the 16 nearest input cell centers and their values

WHAT DO I REALLY NEED?

- Orthogonality?
  - Yes, because if not what cell values do I use?

- Concurrency?
  - Helps, but if some cells only exist within extents of one raster, then no calculation is possible

- All cells have a value (i.e. same masked extents)?
  - Sort of... can only do MOST calculations (e.g. subtraction) when all rasters have a value
  - Some operations (e.g. max) may still be possible
ENVIRONMENT SETTINGS

Tool environment settings

Tool environment settings inherit from application environment settings: when you open a tool's dialog box and click the Environment button, the application environment settings are used as the initial values for the tool's environment settings.

Note: Tool environment settings only apply to the current run of the tool and do not update the application environment settings.

PROCESSING EXTENT -> ENV. SETTING S

- This is how you force grid concurrency
- Extent -> Limits
- Snap... aligns
TODAY’S PLAN

I. Contours
II. Raster Analyses
   I. Some Basics
   II. Map Algebra
      III. Map Algebra in ARC

USING MAP ALGEBRA IN ARC

• Setting the Analysis Environment
• The Raster Calculator
SYNTAX….

The operators in the Raster Calculator tool dialog box are:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/ (Division)</td>
<td>1 (Equal To)</td>
</tr>
<tr>
<td>* (Multiplication)</td>
<td>&gt; (Greater Than)</td>
</tr>
<tr>
<td>- (Subtraction)</td>
<td>&lt; (Less Than)</td>
</tr>
<tr>
<td>+ (Addition)</td>
<td>&lt;= (Less Than or Equal To)</td>
</tr>
<tr>
<td>&lt; (Equal To)</td>
<td>&gt;= (Greater Than or Equal To)</td>
</tr>
<tr>
<td>(Boolean And)</td>
<td>(Boolean Or)</td>
</tr>
<tr>
<td>(Boolean Not)</td>
<td></td>
</tr>
</tbody>
</table>

- It can be picky... use the operator buttons to help you…

TODAY’S PLAN

I. Contours
II. Raster Analyses
   I. Some Basics
   II. Map Algebra
   III. Map Algebra in ARC
WHAT DOES ‘COMBINING’ MEAN?

We’ve worked with raster & vector data throughout the semester...

• Does it mean preserving data type but using both to:
  - Convey information?
  - Perform analyses?

• Does it mean conversion?
  - e.g. Raster -> Vector
  - e.g. Vector -> Raster

TODAY’S PLAN

I. Review
II. Using Vector & Raster Data Simultaneously to:
   I. Convey Information
   II. Perform Analyses
III. Converting Between Raster & Vector Data Types
   I. Types of Conversions
   II. Classification
   III. Interpolation
   IV. Analysis
IV. Summary & Reminders
TODAY’S PLAN

I. Review

II. Using Vector & Raster Data Simultaneously to:
   I. Convey Information
   II. Perform Analyses

III. Converting Between Raster & Vector Data Types
   I. Types of Conversions
   II. Classification
   III. Interpolation
   IV. Analysis

IV. Summary & Reminders

REVIEW – DISCRETE vs. CONTINUOUS

• Spatially Continuous Fields
  - Only rasters can represent continuous fields

• Spatially Discrete Objects
  - Vector data (points, polygons, polylines) are always spatially discrete
  - Raster data can be discrete (only when represented as an integer)

TODAY’S PLAN

I. Review
II. Using Vector & Raster Data Simultaneously to:
   I. Convey Information
   II. Perform Analyses
III. Converting Between Raster & Vector Data Types
   I. Types of Conversions
   II. Classification
   III. Interpolation
   IV. Analysis
IV. Summary & Reminders

USING VECTOR & RASTER DATA SIMULTANEOUSLY

• Overlaying information for better context...
  - LAYERS!
A GEOLOGY MAP: JUST GEOLOGY...

A GEOLOGY MAP: MORE VECTOR DATA

Data from Utah Geological Survey: http://geology.utah.gov/
A GEOLOGY MAP: ADD DRG USGS BASE

A Portion of the Geologic Map of the Logan 30' x 60' Quadrangle

Data from Utah Geological Survey: http://geology.utah.gov/

A GEOLOGY MAP: ADD HILLSHADE RASTER

A Portion of the Geologic Map of the Logan 30' x 60' Quadrangle

Data from Utah Geological Survey: http://geology.utah.gov/

Topographic Data from: http://gis.utah.gov/
CONTEXT OF AN AERIAL PHOTO...

- These vector data are draped (elevated) according to a raster DEM
- Combining the data with an orthophoto helps set the context

TODAY’S PLAN

I. Review
II. Using Vector & Raster Data Simultaneously to:
   I. Convey Information
   II. Perform Analyses
III. Converting Between Raster & Vector Data Types
   I. Types of Conversions
   II. Classification
   III. Interpolation
   IV. Analysis
IV. Summary & Reminders
PERFORMING ANALYSES

Most examples are of using vector data to analyze or sample raster data

- **Extraction**: Using *points* to extract raster values at specific locations on a raster
- **Profiling**: Using *polylines* to extract raster values along a route
- **Spatial Masking**: Using *polygons* to perform a segregated raster analysis
- **Clipping**: Using *polygons* to trim a dataset down...

---

EXTRACTION

- Use points showing spawning locations to extract water depth values from the raster

Spawning locations of Chinook Salmon (red) overlaid on a water depth map – Mokelumne River
**SAMPLING**

- Extraction for multiple layers

**PROFILING**

Extract raster values (DEM elevations) along a polyline at every vertex...

5 m DEM Data from: [http://gis.utah.gov/](http://gis.utah.gov/)
MASKING


CLIPPING

We just want the DEM for our study Watershed (Wood Camp Hollow)

Use a polygon to clip a raster dataset

GIS Data from: http://gis.utah.gov/

Slides from USU Advanced GIS Courses by Wheaton et al. (2009-2013) is licensed under a Creative Commons Attribution-NonCommercial-ShareAlike 3.0 Unported License
LEAST-COST PATH

- A cost raster identifies the cost of traveling through each cell.

Slope... Landuse...

So steep and forested is expensive; flat & urban cheap

TODAY’S PLAN

I. Review
II. Using Vector & Raster Data Simultaneously to:
   I. Convey Information
   II. Perform Analyses
III. Converting Between Raster & Vector Data Types
   I. Types of Conversions
   II. Classification
   III. Interpolation
   IV. Analysis
IV. Summary & Reminders
TYPES OF CONVERSIONS

Vector to Raster
• Point to Raster
• Polyline to Raster
• Polygon to Raster

Raster to Vector
• Raster to Point
• Raster to Polyline
• Raster to Polygon

POINT TO RASTER
• Various ways to convert points to a raster
• When multiple points are in a cell, its based on combination of most frequent & priority
• When points are sparse, just the cells with a point get a value, the rest are no data
• Choice of raster resolution critical!
**POLYLINE TO RASTER**

- A common method of going from one discrete representation to another
- Applications:
  - Classifications
  - Boundaries
  - Masks
  - Boolean Logic

**POLYGON TO RASTER**

WHY BOTHER CONVERTING TO RASTER?

- Raster Math (allowing global cell-by-cell calculations using raster calculator)
- Rasters are easy to export and many spatial models are raster based
- There are a plethora of raster-based analyses available

RASTER TO POINT

- Extracts the raster value and assigns it to a point located at the center of each grid cell
- Useful if you need to have continuous data discretized to finite number of points (e.g. a uniform stakeout)

RASTER TO POLYLINE: DRAINAGE NETWORK DEFINED

- Connect cells above threshold
- Stream Order

We’ll talk about this in next Tuesday's Lecture

RASTER TO POLYGON

- Only works for discrete (integer) or classified rasters
  - Can't convert DEM
  - But a reclassified DEM into elevation bands can be...
  - Watershed delineations can also be converted
TODAY’S PLAN

I. Review
II. Using Vector & Raster Data Simultaneously to:
   I. Convey Information
   II. Perform Analyses
III. Converting Between Raster & Vector Data Types
   I. Types of Conversions
      II. Classification
      III. Interpolation
      IV. Analysis
IV. Summary & Reminders

CLASSIFICATION TENDS TO BE
RASTER -> VECTOR

• If manual, we call this digitizing

A special case of raster -> polygon

Classification Tends to Be Raster -> Vector

Slides from USU Advanced GIS Courses by Wheaton et al. (2009-2013) is licensed under a Creative Commons Attribution-NonCommercial-ShareAlike 3.0 Unported License
### IMAGE CLASSIFICATION

- Buildings
- Streets
- Sidewalks
- Landscaping
- Water
- Vegetation

- Primarily raster-based classification of continuous surfaces into discrete integer surfaces; then converted to vectors

---

### TODAY’S PLAN

I. Review

II. Using Vector & Raster Data Simultaneously to:
   - Convey Information
   - Perform Analyses

III. Converting Between Rater & Vector Data Types
   - Types of Conversions
   - Classification
   - **Interpolation**
   - Analysis

IV. Summary & Reminders
INTERPOLATION...

- Many types of interpolation
- Based on assumption of spatial correlation

We'll talk about this in next Thursday's Lecture (week from today)

BUILDING A TIN FROM VECTOR DATA

A Triangular Irregular Network (TIN) is the simplest and most common interpolation technique for building surfaces with irregularly spaced elevation data (McCullagh, 1981)

What is an appropriate grid resolution?

- Should be fine enough to resolve ______
- Should not be too much finer than the resolution of available data
- Some \( f(\text{topographic complexity, point density}) \)

BUT...

### The N-Squared Problem

<table>
<thead>
<tr>
<th>Resolution (m)</th>
<th>Dimensions</th>
<th>Total # of Cells</th>
<th>Bytes (Double 64 bit)</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>2 x 2</td>
<td>4</td>
<td>32</td>
</tr>
<tr>
<td>50</td>
<td>4 x 4</td>
<td>16</td>
<td>128</td>
</tr>
<tr>
<td>25</td>
<td>8 x 8</td>
<td>64</td>
<td>512</td>
</tr>
<tr>
<td>20</td>
<td>10 x 10</td>
<td>100</td>
<td>800</td>
</tr>
<tr>
<td>10</td>
<td>20 x 20</td>
<td>400</td>
<td>3200</td>
</tr>
<tr>
<td>5</td>
<td>40 x 40</td>
<td>1600</td>
<td>12,800</td>
</tr>
</tbody>
</table>

- Doubling the resolution squares the number of cells!
- Arbitrary increases in resolution lead to larger file sizes and longer computational time...
TODAY’S PLAN

I. Review
II. Using Vector & Raster Data Simultaneously to:
   I. Convey Information
   II. Perform Analyses
III. Converting Between Raster & Vector Data Types
   I. Types of Conversions
   II. Classification
   III. Interpolation
IV. Analysis
IV. Summary & Reminders

ANALYSIS

• Conversions, classifications and interpolation have all been shown to be useful forms of analysis
• Are there any other analyses that result in a conversion between vector and raster, but that are not direct conversions, classifications or interpolation?
  • Density
    • Kernel Density
    • Line Density
    • Point Density
SURVEY POINT DENSITY

A unique type of moving window analysis that produces a density raster from point vector data.

ANOTHER DENSITY EXAMPLE...

- Bonneville Cutthroat Trout

- Can we identify hot spots where these fish are found in high densities?
**PIT TAG LOCATIONS**

- Mobile antennae surveys
- PIT tags plotted from Lat/Long coordinates
- What’s wrong with these?

**THE NEAR TOOL**

- Analysis Tools > Proximity > Near
- Location must be checked
**PIT TAGS SNAPPED**

Points “snapped” to the stream by plotting the new coordinates from the Near tool.

**POINT DENSITY TOOL**

The Point Density Tool creates a raster based on characteristics of an input point feature.
POINT DENSITY OUTPUT

This doesn’t do much good without better symbology or a reclassification.

RECLASSIFICATION

- Density units odd... so just used 10 equal interval breaks and turned zeros into NoData
BROWN & CUTTHROAT TROUT HOTSPOTS

Cutthroat and Brown Trout Utilization Hotspots in Temple Fork

Legend
Cutthroat Density Value
- High: 10
- Low: 1
Brown Density Value
- High: 10
- Low: 1

From Ryan Lokteff

WHAT IF I WANTED TO GO BACK TO LINE?

• I want to attribute the line...
• So instead of density being points per area, they'd be Points per unit or Points per length of line...

Data from Ryan Steve Bennett (ELR)
FLUVIAL AUDIT... POOL INVENTORY

• How many pools are in each reach?
• OR What reach are the pools in?
• Isn’t this just a vector data question?

WHAT I WANT IS...

• A new column that has how many pools (i.e. points) in each reach (just counts)
• Then I can use field calculator to divide by reach length...
ACTUALLY...

- Deciding exactly what you want/need to address a question is the challenge...
- Lots of ways to get there...

To get what reach pools are in:
- Ran a Buffer Analysis on stream polyline to create a polygon buffer with Flat End type of 10 m around stream reach
- Did a Spatial Join to bring the column from the reach file over to the point features (pools in this example)...

TODAY’S PLAN

I. Review
II. Using Vector & Raster Data Simultaneously to:
   I. Convey Information
   II. Perform Analyses
III. Converting Between Raster & Vector Data Types
   I. Types of Conversions
   II. Classification
   III. Interpolation
   IV. Analysis

IV. Summary & Reminders
TODAY’S SUMMARY

Analysis combining raster and vector data can:
• preserve data type but use both to:
  - Convey information more clearly
  - Perform analyses otherwise not possible
• mean converting between
  - Raster -> Vector
  - Vector -> Raster

READING FOR NEXT THURSDAY

ADVANCED GIS COURSES
WATS 4930/6920, 4931/6921, 6915

Reading for Thursday, March 21st
posted a minute ago by Joe Wheaton
Read Chapter 11 on Terrain Analysis from Boccard (2008)